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Define Data Analysis 
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Define Table 

 

 

Delimiters and Text Files 
1. Delimiter = character/s that separate bits of data 

2. Delimited Table = Field Names and Data in Records separated by Delimiter 

3. Text Files = files that can transport tables of data from one system to another, such as 

transporting database data to Power Query and then Excel. 

4. Common Text Files: 

• .csv file = Comma Delimiter 

• .txt file = Tab Delimiter 
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Excel Table Feature 
1) If you have a proper data set, you can convert your proper data set to an Excel Table by 

selecting one cell in the proper data set, click on the Table button in Table group in Insert 

Ribbon Tab, or just use keyboard: Ctrl + T. 

2) The advantage to using the Excel Table feature is that when new rows or columns are added to 

the Excel Table, all objects, such as PivotTable, Charts, Formulas, or other features can be 

refreshed, and the new data will be incorporated into the object. 

3) You can name your Excel Table: select one cell in Excel Table, click the Table Design Ribbon 

Tab, Properties group. You can NOT use spaces in the Table Name. 

4) You can add new records to Excel Table by typing or pasting new data in the first row below 

the Excel Table. 

5) Filter and Sort dropdown arrows at top of each field allow you to sort or filter the records in 

the Excel Table. 

6) The Total Row can contain aggregate calculations such as sum or average. This total row 

automatically moves downward when new records are added to the table. 

7) If new rows and columns are not added to Excel Table, you will need to change option settings 
for Excel Tables: File menu, Options button, Proofing tab on left, “AutoCorrect Options” 
button, check “Include new rows and columns in table”. 

Sort & Filter Features 
1) Sort Feature 

i. To sort means to organize the records in a table from smallest to biggest (A-Z, or 

ascending) or biggest to smallest (Z-A, or descending), based on a specified column. 

ii. When you sort a column in a proper data set, the records in the table are sorted based 

on the order of the sorted column. 

iii. If you have mixed data, an A to Z sort would sort in this order (top to bottom): Numbers, 

Text, FALSE, TRUE, Errors, Empty Cells 

1. Empty Cells are always sorted to the bottom whether you do A to Z or Z to A). 

2) Filter Feature 
i. To filter means to show only certain records, based on one or more conditions from one 

or more columns. Any type of logical test can be used to filter a table. Examples of 

Logical Tests: 

1. AND Logical Test = All Conditions must = TRUE. When you use two columns for a 

filter, you are performing an AND Logical Test. 

2. OR Logical Test = At least one condition must = TRUE. One or more conditions 

must = TRUE. When you use two conditions from a unique list on one column for 

a filter, you are performing an OR Logical Test. 

ii. When you filter based on conditions, the matching records are shown, and the non-

matching records are hidden. 
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FlashFill  

1) If you have a one-time data cleaning task, and the pattern for extracting data is the same for 
every row in the table, then Flash Fill is the tool you want to use. However, if the pattern is not 
consistent in every row, then Flash Fill can be hard to use and may even give you incorrect 
results, especially if you have a large dataset where it is hard to determine whether a perceived 
pattern is the same in every row. When Flash Fill cleans data, the solution created does not 
automatically update if the source data changes, so Flash Fill is usually not a good tool for data 
analysis solutions that will later be updated with new data. Power Query and worksheet 
formulas are designed specifically for situations where you will get new data later and you 
need the solution to update. If there is a consistent pattern, you can clean data by typing 
example to right of column of data, then click FlashFill button or Ctrl + E. 

2) The three rules for using FlashFill are: 
i. You have a one-time data cleaning task that does not need to be repeated 

ii. You will not get more data later and need the solution to update 

iii. There is a simple pattern in the data that you can use to provide an example 

Standard PivotTable Notes  

2) What PivotTables do: 
i. Create Summary Reports that contain calculations with Conditions or Criteria. 

3) Summary of how to create PivotTable: 
i. Click in one cell in Proper Data Set 

ii. Insert Ribbon Tab, Tables group, PivotTable button. 

1. Keyboard = Alt, N, V, T. 

iii. From Field List, drag field name to Rows area or Columns area or Filter area. These are 

the conditions/criteria for the calculation in the Values area of the PivotTable. 

1. Fields in the Rows area add a condition/criterion to the row 

2. Fields in the Columns area add a condition/criterion to the column 

3. Fields in the Filter area add a condition/criterion to the entire PivotTable. 

iv. From Field List drag the field you would like to make a calculation on to values area. 

1. Number fields default to a SUM calculation (add numbers) 

2. Text fields default to a COUNTA calculation (count non-empty cells) 

v. With a cell selected in the PivotTable, click on PivotTable Tools Design Ribbon Tab, go to 

the Layout group, click drop-down for Report Layout and then click on “Show in Tabular 

Form” or “Show in Outline Form”. These Layouts shows the Field Names in your Report. 

To set the layout default for all PivotTable, click on File menu, Options button, in the 

Excel Options dialog box, click the Data tab on the left, click the Edit Default Layout 

button, then in Report Layout check box, select “Show in Tabular Form” or “Show in 

Outline Form”. 
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vi. To add Number Formatting to the Values area of the PivotTable, click in one cell in the 

Values area of the PivotTable, Right-click the cell and click on “Number Format…”, then 

in the Number Formatting dialog box select the Number Formatting that you would like 

and then click OK. 

vii. Slicers can be added to the PivotTable to add a condition/criterion to the entire 

PivotTable, similar to a field in the Filter area. To insert a Slicer into a PivotTable, click in 

one cell in the PivotTable Report, then go to the PivotTable Tools Analyze Ribbon Tab, 

then in the Filter Group, click the Insert Slicer button 

viii. If you want to change the summary calculation in the Values area, right-click the Values 

area in the PivotTable Report, point to one of these two options: 

1. “Summarize Values By” and then select an aggregate calculation such as 

“Average”, or “Max”, or “More Options”. 

2. “Show Values As” and then select a calculation such as “% of Column Total”, 

“Running Total”, “Difference From” or other calculations. 

ix. Standard PivotTable vs. Data Model PivotTable. 

1. A Standard PivotTable stores its data in the PivotTable cache. A Standard 

PivotTable is best when data is stored in one small table (less than about 50,000 

rows of data) and you want simple calculations such as sum, averages, % of 

column totals or % of grand total. 

2. A Data Model PivotTable stores its data in the Power Pivot Data Model Columnar 

Database. A Data Model PivotTable is best when you have a large amount of 

data, you have multiple related tables, or you want to make calculations that a 

Standard PivotTable cannot easily make. 

x. Standard PivotTable Cached Data 

1. When you create a Standard PivotTable, Excel creates a copy of the source data 

and stores it in the Pivot Cache. The Pivot Cache is stored in Excel’s memory. 

2. This is why the PivotTable does not update when source data changes. 

3. If source data changes, you can right-click the PivotTable and click Refresh, or use 

the Refresh button in the Data Ribbon Tab. 

4. You can’t see Cached PivotTable Data, but that’s the data the PivotTable 

references when you build your PivotTable or change a Slicer selection or move 

rows/columns around. 

5. When we group dates in a PivotTable, the Pivot Cache is where this action takes 

place. The Pivot Cache save the action of grouping by dates so that when we use 

the date column in other places, the date column will remain grouped. 

6. When we use a Slicer or change the conditions and criteria in the PivotTable, 

these actions are interacting with the Pivot Cache of data, not the original source 

data.  
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Excel Charts  

1) What do Charts do? 
i. Visually portray quantitative data (number data). 

ii. Give a quick impression of the number data. 

iii. Create a picture that can communicate more quickly than just the numbers alone. 

iv. Charts allow you to see patterns or trends that you may not be able to see if you are 

looking at just the number data. 

v. Allows you to make relative comparisons more quickly than if you are using a table 

2) Types of Charts 
i. Column: Use to compare differences across categories. Height of column conveys 

number. 

ii. Bar: Use to compare differences across categories. Length of bar conveys number. 

iii. Stacked Column/Bar: Good for displaying crosstabulation, emphasis on horizontal axis 

categories. 

iv. Clustered Column/Bar: Good for displaying crosstabulation, emphasis on legend 

categories. 

v. Line: Use to show trend for a number variable over a category such as time. 

vi. X-Y Scatter: Used to show relationship between two number variables (x and y). 

3) Rules for Charts: 

i. No Chart Junk. 

ii. Eliminate all chart elements that do not help to communicate the message. 

4) Formatting Charts: 

i. You can add and remove chart elements by using the Green + on the right side of 

chart. 

ii. To format a chart element, select element and use the keyboard Ctrl + 1 to open the 

Format Chart Element task pane. 

5) Link Labels to Cells 
i. Click on Chart Title, type an equal sign, click on cell with title, hit Enter. 

Data Modeling 

1) Data modeling involves getting the source data into the correct form so that you can easily 
create reports, visuals, and other useful information. 

2) Examples: 
ii. Using the XLOOKUP function to add columns to a single flat table which you can use 

with the Standard PivotTable. 

iii. Using Power Query to convert 12 test files into one table. 
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Dashboards: 
1) One location where we can present useful information & metrics for making decisions. 

2) Information is presented in a neat an organized manner. 

3) Dashboards may contain: tables, charts, visualizations, data validation, pictures, other 
visualizations of data. 

4) Dashboards can be created on an Excel Worksheet, a Power BI Page or in a sharable location in 
a workspace at Power BI Online. 

5) When new data arrives, the dashboard can be refreshed. 

6) Just like a dashboard in a car, a dashboard should present information that is required for 
making good decisions. 

Fact Table, Dimension Table, Primary Key, Foreign Key, Relationships 
Fact table: A fact table contains the data that you want to summarize or measure (such as sales 

amounts or units sold). Examples of fact tables are tables that store sales transactions, tables that 

store baseball data for baseball games, tables that store customer clicks at a website, and tables that 

store observations from an experiment. The facts are the measurements of activities, such as the 

amount of a sale, the number of balls and strikes in a baseball game, the start and end times for 

someone who visits a website, and the temperature size in an experiment. Fact tables can sometimes 

be very large; they may contain 100,000 rows, 1 million rows, or even 100 million rows or more. 

Dimension table: A dimension table contains a field with a unique list of entities (such as product IDs) 

with attributes in subsequent fields for conditional calculations (such as product names) or lookup 

items (such as product prices). Dimension tables are also called lookup tables. The term dimension 

table is used in data analysis to refer to a lookup table. Remember from Chapter 14 that a lookup 

table always has a unique list of items in the first column of the table (the primary key); it is the same 

with dimension tables. For example, a product dimension table has a unique identifier, usually in the 

first column, such as product name or product ID; an employee dimension table has a unique 

identifier in the first column, such as employee ID or employee name. Dimension tables are usually 

much smaller than fact tables. 

A field with a unique list of entities, called a primary key, is used to ensure that there are no duplicate 

records in the dimension table. When a primary key from a dimension table is used in a fact table, 

from the point of view of the fact table, it is a foreign key. 

In the Data Model in Power Pivot and Power BI Desktop you can connect a primary key and a foreign 

key in a one-to-many relationship, where the one-side is the primary key and the many side is the 

foreign key. When you have multiple tables in a Data Model, a one-to-many relationship can replace 

the XLOOKUP function that you would use in the Worksheet. The advantage of using a one-to-many 

relationship is that it: 1) allow you to use multiple tables in a Data Model PivotTable Field List, 2) use 

DAX lookup functions like RELATED and 3) allows filters to flow from the dimension table to the fact 

table during the DAX Filter Context Process.  
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Power Query  

 

Power Query is in the Data tab in the Excel Ribbon: 

 

Power Query is in the Home tab in the Power BI Desktop Ribbon: 

 

Notes about Power Query from my book The Only App That Matters on next six pages: 
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Power Query Data Source Settings 
You can adjust the data source settings by going to the Data tab in the Excel Ribbon, Get & Transform group, Get Data 

dropdown arrow, then click on Data Source Settings, as shown in picture below. You can change settings such as: 

1. Point Power Query to a new “.csv” file, so query can get the latest data. As shown in Example 5. 

2. Change the “On-premise” file location, when a file changes location. As shown in Example 6. 

3. Adjust settings for an on-line SQL database. As shown in example 10. 
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Power Pivot 

 

 

Notes about Power Pivot from my book The Only App That Matters: 
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Steps to Create DAX Measures 

 

Filter Context for DAX Measures 
Filter context allows DAX measures that are used in a PivotTable, PivotChart, or Power BI visualization to automatically 

use the conditions and criteria in the Rows, Columns, or Filters areas to make conditional calculations. This is the context 

part, where the DAX measure can see the surrounding situation and pick out all the conditions in the context of the 

report or visualization. In addition, when the behind-the-scenes Data Model engine evaluates the DAX context, it does 

not use the full fact table but instead uses only rows that match the conditions. This is the filter part, as the underlying 

tables are filtered down to a smaller size so that the formula has less work to perform and can make the calculation 

more quickly. To see a great video presentation of how Filter Context works, see MECS video #4 at the 01:57:21 minute 

mark.  
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Explicit Measures vs. Implicit Measures 
 

Notes about Power Pivot from my book The Only App That Matters: 
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Advantages of Power Pivot & Data Model as listed in MECS Video #4 at 02:06:37 minute mark: 
1. Relationships rather than many XLOOKUP formulas 

2. Multiple Tables in one PivotTable Report 

3. Reusable & Formattable DAX Measures 

4. The Columnar Database allows you to use tables with millions of rows of data 

5. Hide Unnecessary Field 

6. Filter Context helps with Big Data 

7. Can Send Data Model to Power BI Desktop 
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Power BI Desktop 

 

Live link to download Power BI Desktop: https://powerbi.microsoft.com/en-us/desktop/ 

Note about Data Model / Semantic Model: 
Power BI changed the term “Data Model” and “Dataset” to the new term: "Semantic Model". "Semantic Model" = “Dataset” = "Data Model". 

The definition of a "Semantic Model" /“Dataset” / "Data Model" is: 

Semantic models present a mapping of the tables, columns, hierarchies, relationships, measures and other model components that sits between the underlying 

data sources and the workbooks, reports, dashboards and analysis. Semantic models should match the structure and data security needs of the business. 

Sematic models serve as the single source of truth that end users can connect to easily and interpret easily so that they can create consistent, data-driven and 

useful information for decision makers. 

 

Notes about Power BI Desktop and Power BI Online from my book The Only App That Matters on next pages: 

https://powerbi.microsoft.com/en-us/desktop/
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Notes about Power BI Online 
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Compare Reporting & Visualization tools: 
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Example 1 -3 
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Example 4 
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Example 5 
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Example 6 
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Example 7 
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Example 8 
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Example 8 Data Model 
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Example 9 

 

Power BI Finished Interactive Dashboard: 
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Example 9 data Model 
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Example 10 

 

 

Power BI Finished Interactive SQL Gross Profit Dashboard and World Sales Map: 
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Example 10 Data Model 

 


